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A Caution

Before you start the implementation, make sure that you have the latest version of this document. You can
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Viewer Administration Guide
Document History

PUBLIC


http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com

Version Date Description

3.10 November 24, 2016 Updated for version 9.0 FPO1

3.20 April 27, 2017 Updated for version 9.0 FPO2

3.30 September 07, 2017 Updated for version 9.0 FPO3

340 December 15, 2017 Updated for version 9.0 FPO4

3.50 June 14, 2018 Updated for version 9.0 FPO5

3.60 October 25, 2018 Update for 9.0 FPO6.

3.70 May 23, 2019 Update for 9.0 FPO7.

Viewer Administration Guide

4 PUBLIC Document History



1 Getting Started

11 About This Document

This Administrator’'s Guide is the central source of information for the technical implementation of SAP 3D
Visual Enterprise Viewer. It provides cross-scenario implementation information as well as scenario-specific
information.

You can use the Administrator’s Guide to get an overview of SAP 3D Visual Enterprise Viewer and its software
units from a technical perspective. The Administrator’'s Guide is a planning tool that helps you to design your
system landscape and it refers you to the detailed documentation that is required, mainly:

e |nstallation guides for single software units
e SAP Notes

e Configuration documentation

e SAP Library documentation

This Administrator’s Guide is a single source of information for the documentation that is available to support
the installation and operation of SAP 3D Visual Enterprise Viewer. Therefore, this guide contains all of the
following:

e |[nstallation Information
This chapter gives you an overview of the installation components and the sequence in which they are installed.
e Security Information

This chapter provides you with the information that you require to operate SAP 3D Visual Enterprise Viewer
securely.

e Upgrade Information

This chapter provides you with the latest upgrade information.
i Note

You can find the most current version of this document at http://help.sap.com# |+ SAP 3D Visual

Enterprise Viewer 3.

We strongly recommend that you use the document available there. The guide will be updated according to
updates of the software.

1.2 SAP Notes for the Installation

Read the following SAP Notes before you start the installation. These SAP Notes contain the most recent
information on the installation, as well as corrections to the installation documentation.
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Make sure that you have the up-to-date version of each SAP Note, which you can find at the Internet address:
https://support.sap.com/notes .

SAP Note Number

Title

Description

2176101 #% Removal of NPAPI Support in Chrome ~ Removal of Chrome support as of April
affecting SAP 3D Visual Enterprise 2015
Viewer

2776183%r

Java dependencies for SAP 3D Visual

Enterprise Viewer

Describes version change for Java.

1.3 Information Available

Help Documentation

Description

Internet Address

Title

SAP 3D Visual Enterprise Viewer

http://help.sap.com/l"h-lb SAP 3D Visual
Enterprise Viewer > SAP 3D Visual Enterprise

Viewer [Version number] }

Application Help for SAP 3D Visual En-
terprise Viewer

SAP 3D Visual Enterprise Author

http://help.sap.com/ P | SAP 3D Visual
Enterprise Author > SAP 3D Visual Enterprise

Author [Version number] 1

Application Help for SAP 3D Visual En-
terprise Author

SAP 3D Visual Enterprise Link

http://help.sap.com/ " | SAP 3D Visual
Enterprise Link > SAP 3D Visual Enterprise

Link [Version number] }

Application Help for SAP 3D Visual En-
terprise Link

SAP Visual Enterprise Access

http://help.sap.com/ P | SAP Visual

Enterprise Access > SAP Visual Enterprise

Access 71 4

Application Help for SAP Visual Enter-
prise Access

SAP 3D Visual Enterprise Genera-

tor

http://help.sap.com/P|l SAP 3D Visual

Enterprise Generator > SAP 3D Visual

Enterprise Generator [Version number] ]

Application Help for SAP 3D Visual En-
terprise Generator
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User Guides

Description

Internet Address

Title

SAP 3D Visual Enterprise Viewer

http:/help.sap.com# | SAP 3D Visual
Enterprise Viewer } SAP 3D Visual

Enterprise Viewer [Version number] ]

Administrator’'s Guide for SAP 3D Visual
Enterprise Viewer

SAP 3D Visual Enterprise Viewer
for iPad

http://help.sap.com P"hvlb SAP 3D Visual
Enterprise Mobile ]

Administrator’s Guide for SAP 3D Visual
Enterprise Viewer for iPad

SAP 3D Visual Enterprise Viewer
for Android

http:/help.sap.com# | SAP 3D Visual
Enterprise Viewer > SAP 3D Visual

Enterprise Viewer [Version number] }

Administrator’'s Guide for SAP 3D Visual
Enterprise Viewer for Android

Security Guide for SAP 3D Visual
Enterprise Generator

http://help.sap.com# | SAP 3D Visual
Enterprise Generator ¥ SAP 3D Visual

Enterprise Generator [Version number] }

Security Guide for SAP 3D Visual Enter-
prise Generator

Application Operations Guide for
SAP 3D Visual Enterprise Gener-
ator

http:/help.sap.com# | SAP 3D Visual
Enterprise Generator > SAP 3D Visual

Enterprise Generator [Version number] ]

Application Operations Guide for SAP 3D
Visual Enterprise Generator

Installation Guide for SAP 3D Vis-

ual Enterprise Generator

http://help.sap.com I"hrl} SAP 3D Visual
Enterprise Generator > SAP 3D Visual

Enterprise Generator [Version number] ]

Installation Guide for SAP 3D Visual En-
terprise Generator

SAP 3D Visual Enterprise struc-
ture manager

http:/help.sap.com# | SAP 3D Visual

Enterprise structure manager 1

Administrator's Guide for SAP 3D Visual
Enterprise structure manager

General Quick Links

Description

Internet Address

Title

Released platforms

https://www.sap.com/products.html

L4

To access the Platform Availability Ma-

trix directly, enter http://
support.sap.com/pam

System sizing

https://www.sap.com/about/bench-
mark/sizing.quick-sizer.html#quick-si-

zerfier

Quick Sizer tool

Viewer Administration Guide
Getting Started

PUBLIC


http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com
http://help.sap.com/disclaimer?site=https%3A%2F%2Fwww.sap.com%2Fproducts.html
http://help.sap.com/disclaimer?site=https%3A%2F%2Fwww.sap.com%2Fproducts.html
http://help.sap.com/disclaimer?site=http%3A%2F%2Fsupport.sap.com%2Fpam
http://help.sap.com/disclaimer?site=http%3A%2F%2Fsupport.sap.com%2Fpam
http://help.sap.com/disclaimer?site=https%3A%2F%2Fwww.sap.com%2Fabout%2Fbenchmark%2Fsizing.quick-sizer.html%23quick-sizer
http://help.sap.com/disclaimer?site=https%3A%2F%2Fwww.sap.com%2Fabout%2Fbenchmark%2Fsizing.quick-sizer.html%23quick-sizer
http://help.sap.com/disclaimer?site=https%3A%2F%2Fwww.sap.com%2Fabout%2Fbenchmark%2Fsizing.quick-sizer.html%23quick-sizer

1.4 Information Available in SAP Support Portal

You can find information on the following areas in the SAP Support Portal:

General Quick Links

Description

Internet Address

Title

SAP Notes

https://support.sap.com/notes

SAP Software Distribution Center (soft-
ware download and ordering of soft-
ware)

https:/support.sap.com/swdc

SAP Product Availability Matrix

https://support.sap.com/release-up-

grade-maintenance/pam.htm|
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2 SAP 3D Visual Enterprise Viewer 9.0

SAP 3D Visual Enterprise Viewer 9.0 can run as a standalone viewer, or as an ActiveX control embedded in
Microsoft Office, NetWeaver, SAP GUI, or HTML. You can use it to view 2D and 3D output from other SAP 3D
Visual Enterprise tools. It is required to insert and view 3D content embedded in Microsoft Office Documents.
SAP 3D Visual Enterprise Viewer is designed to work with Microsoft PowerPoint, Word, and SAP 3D Visual
Enterprise Author to view 3D content.
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2.1 System Landscape

The following graphic shows the system landscape for SAP 3D Visual Enterprise Viewer with the required
software units and the required business functions:

Visual Enterprise Viewer

SAP GUI

SAP Visual Enterprise NetWeaver
Viewer 9.0 3" party applications
(ActiveX)

SAP 3D Visual Enterprise Viewer

Viewer Administration Guide
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2.2 Overall Implementation Sequence

This application is standalone, and does not integrate with a back-end system, so there is no equivalent
installation sequence. SAP 3D Visual Enterprise Viewer is installed directly onto your desktop, with no reliance
on any other software or hardware.

Viewer Administration Guide
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3 Installation Information

SAP 3D Visual Enterprise Viewer 9.0 is installed directly onto your desktop, with no reliance on any other
software or hardware.

- Recommendation

The installer only upgrades from SAP 3D Visual Enterprise Viewer 7.1.x version to SAP 3D Visual Enterprise
Viewer 9.0 version. If you have an earlier release than 7.1, it is recommended that you uninstall the previous
version of SAP 3D Visual Enterprise Viewer first, and then install SAP 3D Visual Enterprise Viewer 9.0.

3.1 Installing the Software

This topic describes the process for installing SAP 3D Visual Enterprise Viewer on your computer.

Procedure

12

Close all applications on the computer.

Navigate to, and double-click the VisualEnterpriseViewer xx.exe filein Windows Explorer, where xx
is the version number.

Choose Next when the installer starts. The Front-End Installer screen is displayed.

Do one of the following:

o Select the SAP 3D Visual Enterprise Viewer 9.0 checkbox to install all components of SAP 3D Visual
Enterprise Viewer

o Expand the SAP 3D Visual Enterprise Viewer 9.0 checkbox to select the features to be installed
Click the Next button to choose an install location. Do one of the following:

o Accept the default location in which to install SAP 3D Visual Enterprise Viewer.

o Click Browse, navigate to, and select the installation folder you require.
Choose Next to start the installation.

i Note

The installer firstly performs a check for previous versions of the software, and if detected, the previous
version of SAP 3D Visual Enterprise Viewer is uninstalled.

Choose Close when the installation is complete.

Viewer Administration Guide
PUBLIC Installation Information



i Note

Upon installation SAP 3D Visual Enterprise Viewer will associate with the types . rh, .rhz, and .vds.
All other SAP 3D Visual Enterprise Viewer readable file formats will be associated with only if no other
application is already associated.

3.2 Post-Installation

These are the post-installation steps that are specific for SAP 3D Visual Enterprise Viewer.

Procedure

Creating .rh or .vds files in SAP 3D Visual Enterprise Author for use with SAP 3D Visual
Enterprise Viewer

Load the required files into SAP 3D Visual Enterprise Author, create any required additional content, and use
the Save As functionality to save as . rh or .vds files.

Creating .rh or .vds files in Visual Enterprise Generator for use with SAP 3D Visual
Enterprise Viewer

1. If you are using SAP 3D Visual Enterprise Generator, this can be used to produce . rh or .vds using batch
processing. The creation of . rh and .vds files is an out-of-the-box workflow that can be configured to
produce . rh and .vds derivatives. This can also be configured as an auto translation on checking into SAP
DMS.

2. Configure and run the SAP 3D Visual Enterprise Generator process to produce . rh and . vds files. For
further information on creating . rh and . vds derivatives, refer to the Configuring Derivatives section of the
application help on the SAP Help Portal (http://help.sap.com/#) for SAP 3D Visual Enterprise Generator.

Viewer Administration Guide
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4 Operation Information

4.1

Trace, Log, and Dump Files

Trace files, log files, and dump files are essential for analyzing problems, as they contain details of errors that
occur during a working session. These errors can be interrogated with the log viewer.

Important Log and Trace files for component SAP 3D Visual Enterprise Viewer

Component

Content

File

Path

SAP 3D Visual Enterprise
Viewer

System processes, memory
state

SAP 3D Visual Enterprise
Viewer.log

%userprofile%\AppData
\LocalLow\sap\SAP 3D
Visual Enterprise

Viewer

SAP 3D Visual Enterprise
Viewer

Tracing information, includ-
ing benchmark tracing

SAP 3D Visual Enterprise
Viewer.trc

Suserprofile$\AppData
\LocalLow\SAP\SAP 3D
Visual Enterprise

Viewer

SAP 3D Visual Enterprise

Application information while

SAP 3D Visual Enterprise

\AppData\Roaming\SAP

Viewer itis running Viewer.dmp \SAP 3D Visual
Enterprise Viewer
\Dumps
SAPVE.FileTransfer

The File transfer component is used exclusively by the Dynamic Mockup (DMU) transaction. If you do not run
this transaction then no folder or trace file will be present.

You can change the component settings that are stored in $AppData%\SAP\SAP 3D Visual Enterprise
FileTransfer 1.0\Settings.xml. Thetrace fileislocated at SUSERPROFILE%\AppData\LocalLow\SAP

\SAP 3D Visual Enterprise FileTransfer 1.0\Logs\FileTransfer.trc.

14 PUBLIC
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Setting Name

Description

Log File Location

LoggerSeverityLevel

Specifies what severity levels of log mes-
sages are written into the log file

Valid values by priority from highest to lowest

are:
e Fatal
e frror
e  Warning
® |nfo (default)
e Debug
e None

For example, if the LoggerseverityLevel
is set to Warning, then only messages with
severity level Fatal, Error and Warning are
written into the log file. If the
LoggerSeverityLevel is None, then mes-

sages are not written into the log file.

%USERPROFILE%\AppData\LocalLow\SAP
\SAP 3D Visual Enterprise
FileTransfer 1.0\Logs
\FileTransfer.log

TracerSeverityLevel

Specifies what severity levels of trace mes-
sages are written into the trace file

Valid values and their meanings are the same
as for LoggerSeverityLevel.

If TracerSeverityLevel is lower than
LoggerSeverityLevel, all messages writ-
ten into the log file are duplicated in the trace
file.

%USERPROFILE%\AppData\LocalLow\SAP
\SAP 3D Visual Enterprise
FileTransfer 1.0\Logs

\FileTransfer.trc

MaxParallelDownloadTas

kCount

Specifies the maximum number of parallel
download tasks.

Valid values: non-negative integer
Default value: 8

Zero (0) value means use up to the number
of virtual processors in the computer.

MaxDownloadRedirection

Count

Specifies the maximum number of URL redi-
rections allowed when downloading one file.

Valid values are: non-negative integer.
Default value: 8

Zero (0) value means that URL redirections
are not allowed.

Viewer Administration Guide
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Benchmark Tracing Information

SAP 3D Viewer includes benchmark tracing information. To enable the trace logs, add the Registry key
manually: HKEY CURRENT USER\Software\SAP\SAP 3D Visual Enterprise Viewer\Plugins\

{ASE67F33-6DE8-4C19-93B1-197E6963435B}.

The benchmark trace is enabled by default in the registry with the following attributes:

® Name: import enable tracing
® Type:REG_DWORD
e Data:l

i Note

Set value to O to turn the trace off.

The benchmark information is written into a . trc file. The . trc file contains the following benchmark

counters:

Counter Type

Description

Total time spent on loading a vzxml file milliseconds

Time spent on parsing a vzxml file milliseconds
Time spent on enqueuing referenced milliseconds
files

Cumulative counters

Total tasks

The total number of download tasks

Succeeded tasks

The number of succeeded download
tasks

Cancelled tasks

The number of cancelled tasks

Failed tasks

The number of failed tasks

Tasks caused waiting

The number of tasks caused waiting.
See Time spent on waiting for a file to be
downloaded below.

Average waiting duration milliseconds The average time spent on waiting for
one task caused waiting. See Time
spent on waiting for a file to be
downloaded below.
Total task group duration milliseconds The total time spent on downloading all
referenced files
Viewer Administration Guide
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Counter Type Description

Average task total duration milliseconds The average total time spent on down-
loading one referenced file

Average task In queue duration milliseconds The average time spent by one file in
the queue before being processed for
downloading

Average task In progress duration milliseconds The average time spent on downloading
one file

Average task Awaiting response dura- milliseconds The average time spent on awaiting re-

tion sponse from a server when download-
ing one file

Average task Download content dura- milliseconds The average time spent on actual trans-

tion

mission of content of one file over the
network

Average task download speed

kilobytes per second

The average speed of downloading one

file

Average task content size kilobytes The average size of one file.

Total content size kilobytes Total size of all files downloaded from a
server

Total URI redirection count The total number of URI redirections
occurred while downloading all files

Per file counters

Time spent on waiting for a file to be milliseconds Files are downloaded in parallel in back-

downloaded ground. By the time when a file is going
to be processed it might happen that it
is not downloaded yet. This counter
shows how much time was spent on
waiting.

Total duration milliseconds The total time spent on downloading
the file

In queue duration milliseconds The time spent by the file in the queue
before being processed for download-
ing

In progress duration milliseconds The time spent on downloading the file

Awaiting response duration milliseconds The time spent on awaiting response

from a server when downloading the file

Viewer Administration Guide
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Counter Type Description

Download content duration milliseconds The time spent on actual transmission
of content of the file over the network

Average download speed kilobytes per second The average speed of downloading the
file

Content size kilobytes The size of the file

Redirection count The number of URI redirections occur-

red while downloading the file

4.2 Registry Settings

4.2.1 Registry Settings for Saving Files and Loading
Assemblies

There are two Registry settings that may require a manual change if you wish to work with RH files in Legacy
mode.

Saving Files (Compatibility Mode Flag)

The settings for saving files, by default, are always .vds, regardless of the file type with which you are working. If
you are working with .rh files, and wish to save to .rh, you must make changes in the registry to set the
compatibility mode flag. The flag defines SAP 3D Visual Enterprise Viewer Save behavior.

The VDS save is enabled by default in the registry. To save to RH instead, change the attributes to match the
following values:
® SAVE LEGACY MODE Registry Key
® [HKEY CURRENT USER\Software\SAP\SAP 3D Visual Enterprise Viewer]
® SAVE LEGACY MODE "=dword:00000001
o Value of 1 = Saving using Viewer Ul will save RH files
o Value of 0 — Saving using Viewer Ul will save vDs files

If this flag is not set, SAP 3D Visual Enterprise Viewer works in default (Standard) mode. If set, SAP 3D Visual
Enterprise Viewer works in compatibility (Legacy) mode.

Viewer Administration Guide
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Loading Assemblies

The settings for loading assemblies, by default, always support .vds features. If you are working with .rh files,
and wish to load .rh assemblies, you must make changes in the registry to set the compatibility mode flag. The
flag defines SAP 3D Visual Enterprise Viewer Load Assembly behavior.

® LOAD ASSEMBLY LEGACY MODE Registry Key
® [HKEY CURRENT USER\Software\SAP\SAP 3D Visual Enterprise Viewer]
® IOAD ASSEMBLY LEGACY MODE"=dword:00000001
o Value of 1 — Assemblies loaded in embedded ABAP scenarios support all features available for RH files
as in SAP 3D Visual Enterprise Viewer 8.0
o Value of 0 — Assemblies loaded in embedded ABAP scenarios support newer features only available
with VDS files. Assemblies created from RH files will only support features that are also available with
VDS files.

If this flag is not set, assemblies are loaded using new Namespace in default (Standard) mode. If set,
assemblies are loaded using the old Namespace in compatibility (Legacy) mode.

4.2.2 Registry Setting for TIFF Files

There is a Registry setting that may require a manual change if you wish to work with large TIFF files. By
default, SAP 3D Visual Enterprise Viewer switches to software rendering for large TIFF files, which means that
they are not available for collaboration. This setting renders all TIFF files with hardware acceleration, no matter
the file size.

i Note

If you wish to use this functionality, a discrete 3D hardware accelerator video card is required, with at least
4 GB of RAM.

Setting for Hardware Acceleration

Software rending is enabled by default in the registry for large TIFF files. To use hardware acceleration instead,
change the attributes to match the following values:

® [HKEY CURRENT USER\Software\SAP\SAP 3D Visual Enterprise Viewer]
® "USE 2D TIFF VIEWER ALWAYS"=dword:00000001

If this flag is not set, SAP 3D Visual Enterprise Viewer works in default mode. If set, SAP 3D Visual Enterprise
Viewer works with hardware acceleration for all files.

Viewer Administration Guide
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4.2.3 Registry Setting for Loading VDS Shattered
Assemblies

There is a Registry setting that may require a manual change if you wish to work with shattered VDS
assemblies.

Loading Shattered Assemblies

The setting defines loading of VDS shattered assemblies. You can locate Components either by file name or
Component ID.

® HKEY CURRENT USER\Software\SAP\SAP 3D Visual Enterprise Viewer\Plugins\
{C92C054E-B911-4546-B2BD-09E9667A4531}]

® FnableFileScan"=dword
o Value of 1 — Search by Component ID

o Value of — Search by File Name.

If this flag is not set, assemblies are searchable by File Name, which is the default.

Viewer Administration Guide
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5 Security Information

5.1 Sandbox

Some of SAP 3D Visual Enterprise Viewer's supported file formats use third party libraries over which there is
little control in terms of security. This means that vulnerabilities in third party code, encountered when
processing corrupt data from an external, untrusted source, might pose security issues and compromise SAP
products.

Sandboxing provides guarantees about what a piece of code can or cannot do, no matter what the inputs.
Sandboxing leverages the operating system-provided security to allow code execution that cannot make
persistent changes to the computer or access information that is confidential. The architecture and exact
assurances that the sandbox provides are dependent on the operating system.

Security through sandboxing is achieved by granting the sandboxed code the least possible access rights and
privileges, ensuring that it works in accordance with a predefined set of rules. The collection of rules that any
code running in the Sandbox must obey is called a Policy, and no other system resources beyond those defined
in the policy can be accessed or operated on from within the sandbox.

The Sandbox for plug-ins feature is found under either the menu | Edit » Preferences » Security

Configuration 3, or context menu | Preferences # Settings ¥ Security Configuration 3. Sandboxing leverages
the OS-provided security to allow code execution that cannot make persistent changes to the computer or
access information that is confidential. The architecture and exact assurances that the sandbox provides are
dependent on the operating system.

The Sandbox for plug-ins feature also supports the group policy option. Using this, the network administrator
can set a maximum security level and prevent users from changing it. The sandbox handling is implemented
over registry, and is version dependent. The group policy writes to the registry and SAP 3D Visual Enterprise
Viewer uses it to enable or disable sandbox settings.

The .admfileislocated at SAP 3D Visual Enterprise Viewer install folder\Group Policies
\SandBox.adm

Prerequisites

You have:

e A Windows Server setup with a domain
e Full administrative rights to that server
e SAP 3D Visual Enterprise Viewer already installed

Viewer Administration Guide
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Procedure

Installing the SAP 3D Visual Enterprise Viewer Group Policy "SandBox.adm"

1. Log on to the domain server with full administrative rights.
2. Copy the file sandbox .adm from the installation folder of SAP 3D Visual Enterprise Viewer, and paste into a
location in the domain server for installation.

3. From the Windows Start Menu, choose | Administrative Tools @ Group Policy Management 3 .

4. Inthe Group Policy Management tree, right click Group Policy Objects and choose New. Give the group
policy a name, for example, <SAP Group Policy>. The newly added group policy displays under the
group policy objects.

5. Select the newly created policy object, right-click and choose Edit to display the Group Policy Object Editor
window.

6. From the User Configuration folder, right-click Administrative Templates, select Add/Remove Templates,
and choose Add.

7. Browse for the file Sandbox . adm that you have transferred across to the domain server, and open it.

8. Choose Close to apply the changes. A folder entitled SAP 3D Visual Enterprise displays in the
administrative templates. In that folder, double click the Sandbox item to display the sandbox properties.

9. Close the Group Policy Object Editor window to return to the Group Policy Management window. Right-click
the domain to which you want to apply the group policy, and choose Link an Existing GPO. The group policy
object is displayed in the Select GPO, under Group Policy Objects.

10. Log on and run SAP 3D Visual Enterprise Viewer. Check whether the changes in group policy display in the
SAP 3D Visual Enterprise Viewer settings.

i Note

You must log on again to see the updates. This is based on how group policy update is configured.

5.2 URL Redirect Protection

SAP 3D Visual Enterprise Viewer can be embedded in a variety of hosting applications. One of the main usages
is Web applications using SAP 3D Visual Enterprise Viewer to open online files. SAP 3D Visual Enterprise Viewer
achieves this by accepting an URL pointing to an online resource, managing the downloading process and
displaying the content to the user. When an application sends rogue URL with a redirection directive to an
unsafe domain to SAP 3D Visual Enterprise Viewer, it might pose security issues and compromise SAP
products.

The URL Redirect Protection feature provides defence to make sure URLs redirected to an unknown domain
will not be loaded. First, redirecting to the same domain as the source URL will always be allowed. Second,
redirecting to a domain that matches an entry in the white list will also be allowed. All other redirections will be
denied. In case of nested redirection, SAP 3D Visual Enterprise Viewer allows up to 8 levels of redirection in one
URL access. Any more redirection request will be denied.

The URL Redirect Protection main switch and the white list can be set by user. However this setting can be
overridden when there is Group Policy applied by administrator.

When the administrator enables URL Redirect Protection, an entry is required in the white list before the setting
can be applied. The entry does not have to be a valid URL. To stop all redirection, administrator chooses Enable
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URL Redirect Protection and enters some text in the white list. That allows the administrator to apply the
setting.

The URL Redirect Protection settings located under either the menu |+ Edit ¥ Preferences » Security

Configuration 7, or context menu [ Preferences # Settings » Security Configuration 3. The URL Redirect
Protection main switch dictates whether SAP 3D Visual Enterprise Viewer will apply this protection. The white
list is a flat editable list containing URLs that can be redirected when the protection is enabled.

The URL Redirect Protection also supports the Group Policy option. Using this, the network administrator can
set a maximum security level and prevent users from changing it. The Group Policy script file (.adm) is located
at: SAP 3D Visual Enterprise Viewer install folder\Group Policies\URLRedirect.adm

Prerequisites

You have:

e A Windows Server setup with a domain
e Full administrative rights to that server
e SAP 3D Visual Enterprise Viewer already installed

Procedure

Installing the SAP 3D Visual Enterprise Viewer Group Policy URLRedirect.adm

—

Log on to the domain server with full administrative rights.
2. Copy the file URLRedirect .adm from the installation folder of SAP 3D Visual Enterprise Viewer, and paste
into a location in the domain server for installation.

3. From the Windows Start Menu, choose | Administrative Tools » Group Policy Management 3.

4. Inthe Group Policy Management tree, right-click Group Policy Objects and choose New. Give the group
policy a name; for example, SAP Group Policy. The newly added group policy displays under the group
policy objects.

5. Select the newly created policy object, right-click and choose Edit to display the Group Policy Object Editor
window.

6. From the User Configuration folder, right-click Administrative Templates, select Add/Remove Templates,
and choose Add.

7. Browse for the file URLRedirect . adm that you have transferred across to the domain server, and open it.

8. Choose Close to apply the changes. A folder SAP 3D Visual Enterprise displays in the administrative
templates. In that folder, double click the URL Redirect item to display the URL Redirect Protection
properties.

9. Close the Group Policy Object Editor window to return to the Group Policy Management window. Right click
the domain to which you want to apply the group policy, and choose Link an Existing GPO. The group policy
object is displayed in the Select GPO, under Group Policy Objects.

10. Log on and run SAP 3D Visual Enterprise Viewer. Check whether the changes in group policy display in the
SAP 3D Visual Enterprise Viewer settings.
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i Note

You must log on again to see the updates. This is based on how group policy update is configured.
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6 Technical System Landscape

6.1 Supported Operating Systems

SAP 3D Visual Enterprise Viewer can run on three supported operating systems. These are:
e Microsoft Windows 7 64-bit version

e Microsoft Windows 8.1 64—bit version
o Microsoft Windows 10 64-bit version

- Recommendation

We recommend that you use Microsoft Windows 10 64-bit version.

6.2 Hardware Configuration

The minimum configuration for SAP 3D Visual Enterprise Viewer is:

e Corei3 equivalent, or higher
e 8 GB of RAM (more for large model and texture sizes)
e 500GB/1TB (64 bit) hard drive
e \ideo card with the following:
o 24-bit color with pixel and 3D vertex shader support

o 3D hardware accelerator video card, capable of displaying 24-bit color and supporting Shader Model
3.0 with at least 512 MB of RAM supporting Shader Model 3.0
Gigabit Ethernet controller network

- Recommendation

The recommended configuration for SAP 3D Visual Enterprise Viewer is:

® 64-bit multi-core Intel” Core i-7 processor”
e 8 GB of RAM (more for large model and texture sizes)

e 3D hardware accelerator video card, capable of displaying 24-bit color and supporting Shader Model
3.0.with 1 GB of RAM

i Note

To use hardware acceleration for viewing large raster images, a video card with the following is
required:
o Discrete 3D hardware accelerator video card, with at least 4 GB of RAM
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6.3 Extra Requirements

There are a number of extra requirements, depending on the way in which you plan to use SAP 3D Visual
Enterprise Viewer:

Publishing to Office Documents
o Microsoft Office for Windows 2013 (32-bit version only)
o Microsoft Office for Windows 2016 (32-bit version only)
HTML viewing - Browser Client:

o Internet Explorer 9 or later versions

MP4 viewing
o For MP4 media file within steps, there is a video pop-up window which plays the video. For other
formats; for example, AVI and MPG, the video plays inside the viewport.

i Note

The appropriate codec is required to view the media file. You may require a third-party video player
that has required codecs.

Visual Compare

o Graphics Card which supports Direct X 9 and Shader Model 2
HDR Renderer

o Graphics card which supports OpenGL 2.0 and Shader Model 3.0
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7 Upgrade Information

For upgrading, when you install SAP 3D Visual Enterprise Viewer 9.0, any previous versions of SAP 3D Visual
Enterprise Viewer are uninstalled. For regularly updated release and upgrade information, see the SAP Notes at
https://support.sap.com/notes .

i Note

The installer only upgrades from SAP Visual Enterprise Viewer 7.1.x version to SAP 3D Visual Enterprise
Viewer 9.0 version. If you have an earlier release than 7.1, it is recommended that you uninstall the previous
version of SAP 3D Visual Enterprise Viewer first, and then install SAP 3D Visual Enterprise Viewer 9.0.
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8 SAP 3D Visual Enterprise Viewer
Dashboards 4 Add-On v2.0

8.1 Introduction

SAP 3D Visual Enterprise Viewer Dashboards 4 Add-On v2.0 is an add-on for SAP Dashboards 4.1 that contains
a 3D Viewer2 component. The 3D Viewer2 component provides 3D model viewing and 3D analytics capabilities
using SAP 3D Visual Enterprise Viewer.

The 3D Viewer2 component allows 3D models to be displayed in HTML output produced by exporting to HTML
(with Flash). Dashboards allow exporting to various types of output file, but exporting to HTML is the only
option that works when a 3D Viewer2 component is used in a dashboard.

The 3D Viewer2 component must run inside an HTML page in order to allow an ActiveX control to be used in a
Dashboards application implemented in Adobe Flex.

Note that 3D Viewer2 components do not work in the Dashboards preview.

A\ Caution

Two SAP 3D Visual Enterprise Viewer add-ons in the same published Dashboard is not a supported
configuration. The SAP 3D Visual Enterprise Viewer Dashboards 4 Add-on fully supports having both vl and
v2 add-ons loaded in the same design session but a designer is expected to configure a Dashboard using
one add-on.

You can use the 3D Viewer2 component to do the following:

e Visual Indexing
Selecting objects in a 3D scene in order to view or use business data related to the selected objects

e fainting
Modifying the appearance of objects in a 3D scene using a set of rules that are applied to business data
associated with the objects in the scene

e Model Views

Selecting views embedded in 3D models in order to select a particular scene
e Steps

Playing step animations embedded in 3D models
® Queries

Running SAP 3D Visual Enterprise queries against the loaded 3D models

For more information, see http://help.sap.com/# |» SAP 3D Visual Enterprise Viewer ¥ Version # » SAP
Library for Analytics 3D Add-On for Dashboards

i Note

This chapter assumes the user has basic knowledge of creating Dashboards and using SAP 3D Visual
Enterprise Viewer.
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8.2 Installing the Add-On

Installing SAP 3D Visual Enterprise Viewer Dashboards 4 Add-On v2.0 is done through the file management
option in Dashboards. This installs a further component labeled 3D Viewer, which allows you to add and
configure a 3D viewport.

Prerequisites

As a designer, you have installed the following:

e Office 2010

e Dashboards 4.1

e SAP 3D Visual Enterprise Viewer Dashboards 4 Add-On v2.0
e |nternet Explorer 9, 10, or 11

e SAP 3D Visual Enterprise Viewer 9.0

As a runtime user, you have installed the following:

® |[nternet Explorer 9,10, or 11
e SAP 3D Visual Enterprise Viewer 9.0

Procedure

1. Open the Dashboard Designer, and choose Blank Model to open a blank dashboard.

2. From the Dashboard Designer, choose | File » Manage Add-Ons . The Add-On Manager window opens.

3. Choose Install Add-On, browse to new SAP 3D Visual Enterprise Viewer Dashboards 4.0 Add-On and click
Open.

4. Open Dashboards and choose |} File » New » New 3 to open a blank dashboard.

5. In Dashboards, choose |» File » Manage Add-Ons 3.
6. Click Install Add-On, browse to the location of the . x1x file for the SAP 3D Viewer Dashboards 4 Add-On

and click Open. The Add-On Manager dialog shows that the SAP 3D Visual Enterprise Dashboards 4 Add-
On has been installed.
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

o Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
e The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
e SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
e Links with the icon &: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such
links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.
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/contactsap

© 2019 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any form
or for any purpose without the express permission of SAP SE or an SAP
affiliate company. The information contained herein may be changed
without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software vendors.
National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any
kind, and SAP or its affiliated companies shall not be liable for errors or
omissions with respect to the materials. The only warranties for SAP or
SAP affiliate company products and services are those that are set forth
in the express warranty statements accompanying such products and
services, if any. Nothing herein should be construed as constituting an
additional warranty.

SAP and other SAP products and services mentioned herein as well as
their respective logos are trademarks or registered trademarks of SAP
SE (or an SAP affiliate company) in Germany and other countries. All
other product and service names mentioned are the trademarks of their
respective companies.

Please see https://www.sap.com/about/legal/trademark.html for
additional trademark information and notices.

THE BEST RUN
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